
Transform Shadow into Light II



Transform Shadow into Light II © Ben Willmore, All rights reserved 2

Transform Shadow into Light II 

In this lesson, we’re going to learn a technique that will allow us to introduce light 
into shady areas in order to make them look more sunlit. There are actually a cou-
ple of techniques for doing this, and we covered another in a previous lesson with 
the same name (Transform Shadow into Light). The other lesson uses a technique 
that combines two different versions of the same raw image or two bracketed 
exposures. The technique we’re going to use in this lesson will involve using ad-
justment layers in Photoshop. Curves will be the primary adjustment layer, with 
Hue/Saturation being used in a supporting role as well. 

We will first look at the very basic concept and then look at how it’s been applied 
on many different images.

What Differentiates Shady Areas & Sunny Areas (Timestamp 1:11) 

The histogram In order to demonstrate the 
difference between shady and sunlit areas, 
we’re going to look at the Histogram. The His-
togram shows you the brightness range that’s 
found in your image. If it’s not already visible 
in your Photoshop interface, you can access it 
by clicking on the Window menu and choos-
ing Histogram. Black is on the far left. White 
is on the far right, and everything in between 
are all the shades of gray. The bars of the his-
togram show you what shades can be found 
in your picture. 

Note: The histogram will either show you the tones or all of the colors combined. 
You only need to see the tones for this demonstration. If you are instead seeing 
the colors, click on the menu in the upper right corner and choose Expanded 
View. Then use the Channel menu above the histogram to choose Luminosity. 

In the Histogram Panel, the bars on 
the chart represent the tones that are 
found in the image. 
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If you make a selection in the image, the histogram will show you the tonal range 
of the contents of the selection and nothing else. Make a selection of the shaded 
area in your image and you can see how it’s reflected in the histogram. When you 
select the area that’s in the shade, the histogram bars will likely be limited to the 
left side of the chart. This is the side that represents the darker tones. There will 
probably be a huge gap on the right side. 

The goal in adjusting these images is to minimize that gap in order to make the 
histogram for the shadow area look more like the histogram we see when viewing 
the entire image. We want to close the gap in order to make the shady area look 
more like the sunny area. 

A selection is made of the shaded area and the histogram displays the tonal range found 
in that selected area. You can see that the histogram bars are limited to the left side of the 
chart, which means that the selected area contains only dark tones. 
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Lighten the Shady Area Using Curves (5:10) 

Now let’s look at how to lighten that shady area so that it better matches the 
sunny area. First, make a rough selection of the shady area. It doesn’t need to be 
precise to begin with. It just needs to encompass enough of the shady area that 
the histogram knows what tonal range you want to target. In the video example, 
we just used the rectangular marquee tool. 

With that selection active, create a Curves adjustment layer by clicking on the 
adjustment layer icon at the bottom of the Layers Panel and choosing Curves. 
The adjustment layer will appear in the Layers Panel and the selection will auto-
matically be applied to the layer mask that’s attached to the layer. The areas that 
were selected will become the white part of the mask, which is the part of the 
mask where the adjustment will be visible. The Curves Properties Panel will also 
appear, displaying the Curves chart. The histogram can also be viewed within this 
chart, and it will only represent the areas that you had selected. 

We started off by making a basic selection of the shadow area we want to target and lighten.
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There are two ways that you can get rid of the gap on the right side of the histo-
gram and brighten up the area.  

Place point on the curve and move it up Look at where the right side of the his-
togram bars really start getting tall. Click on the curve line to add a point at that 
spot. Then, move the point up, either by clicking and dragging on it or by using 
the up arrow on your keyboard. As you do this, you will see the selected part of 
the image become brighter and brighter. 

Normally, when working with Curves, I would be very mindful to not let the curve 
line cling to the top edge of the chart. That’s because this indicates that part of 
the image is being blown out to white. That’s not going to be an issue in this case, 
however, because the histogram bars do not extend far enough to the right to be 
affected by this top-off. That means that it’s really not affecting anything in the 
targeted area we’re working on. 

A point was placed on the curve, located on the right end of the histogram bars. Here, that 
point is being moved up and the targeted area is becoming lighter. 
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Move the white slider to the left The 
second method for eliminating the 
gap on the right side of the histogram 
is to click and drag on the white slid-
er (just below the histogram chart), 
moving it to the left until it lines up 
with the end of the histogram bars. 
This will cause the brightest portion 
of the shady area to become white. If 
the effect is too extreme, you can al-
ways lower the opacity of the Curves 
adjustment layer. 

Refine the mask After using the Curves settings to lighten the shadows, you will 
likely need to refine the mask so that it precisely targets the shady area. Up until 
now, the selection/mask was very rough. In the video example, we actually start-
ed from scratch when re-creating the mask. We filled the entire mask with black 
(Edit > Fill) so that the adjustment was completely hidden across the whole im-

age. Then, we used the Brush Tool to paint 
with white over the shadow area that should 
receive the lightening effect. If you get any 
overspray with the brush, you can always 
switch to painting with black in order to hide 
the effect again. Note that you can quickly 
swap the foreground and background col-
ors by tapping the X key. If the effect is too 
extreme, you can lower the opacity of the 
adjustment layer. I like to move the Opacity 
slider (at the top of the Layers Panel) all the 
way to the left and then gradually increase 
the opacity until the effect looks ideal and 
natural. 

The white slider 
is being moved 
left so that it 
lines up with the 
right end of the 
histogram bars.

We’re now using the Brush Tool to 
fine-tune the layer mask so that the 
brightening effect is only applied in 
the shadowed area.
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Let’s say that one part of the shadow area needs less of an adjustment than the 
rest. You can use the Fade command to control this. Adjust the opacity of the 
adjustment layer until the majority of the targeted area looks good. Then, paint 
with black (on the mask) over the area that requires less of an adjustment. Use 
one single brush stroke to do this. This will hide the adjustment completely. Then, 
click on the Edit menu and choose Fade. The Fade dialog will appear and it will 
allow you to reduce the strength of the very last thing you did in Photoshop. In 
this case, it’s the strength of that last brush stroke. Adjust the Fade Amount slider 
until the area looks natural. Then click OK to exit the Fade dialog. 

You can follow the processes above multiple times in a document, creating a 
Curves adjustment to target and adjust a specific area. 

The left side of the building needed less of the effect, so we painted (on the mask) over that 
area with black and then used the Fade command to lessen the effect of the brush stroke 
that was just made. 
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Now let’s look at a few tips related to the technique detailed above.

Lock in brightness of dark areas (13:38)

I will sometimes add an extra dot on the curve 
in order to lock in the brightness of the dark 
areas so that they will not be unnecessari-
ly brightened. If the darkest tones become 
brightened, the area might start to lack con-
trast and appear dull. You can click on the 
curve line, somewhere near the black end, 
in order to add that dot, but I like to use the 
Targeted Adjustment Tool. It looks like a little 
hand icon on the left side of the Curves Prop-
erties Panel. With this active, you can click 
within your image and it will place a point on 
the curve that represents the tone/brightness 
level that you clicked on. I will focus on the 
shadow area and click on one of the darkest 
areas within it. 

Clip one Adjustment Layer to another (14:24)

After adjusting or brightening a large area of shade, you may want to go in and 
make additional adjustments for smaller areas within that large shaded area. The 
layer mask for the new adjustment layer[s] will still need to limit the adjustment 
from affecting the sunny area and there is a trick for creating this mask quick-
ly. You can clip one adjustment layer to an underlying adjustment layer in or-
der to limit the adjustment so that it’s as if it is using the layer mask for the 
underlying layer. This means that the underlying layer’s mask is limiting where 
the adjustment is being applied. Place the new adjustment layer above the orig-
inal adjustment layer for the shadow area and add an all-black mask. Then click 

An additional point is added to lock 
in the brightness of the dark areas 
so that they can’t be affected by the 
other curve points. 
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on the Layer menu and choose Create Clip-
ping Mask. When you clip one layer to an-
other, the clipped layer thumbnail becomes 
indented and a little down-pointing arrow 
appears to the left of the thumbnail. Now 
you can paint with white on the mask for the 
new, clipped adjustment layer to reveal the 
adjustment where you want it to be applied. 
As you paint, your paint strokes will be limit-
ed by the underlying mask so that they can 
not affect the sunny area.

Know that you can clip multiple adjustment layers to that first adjustment layer. 
When you clip more than one layer, they will all clip to the next layer down that is 
NOT indented, or clipped to another layer. 

Compensate for Loss of Color (20:10)

When you brighten up a shady area, you might 
find that the result is nowhere near as colorful 
as the areas that are in the sun. You can use a 
Hue/Saturation adjustment layer to compen-
sate for this. After masking the layer to reveal 
only the area you want to adjust, use the Satu-
ration slider in the Properties Panel to make the 
area more colorful. The Hue/Saturation adjust-
ment includes a color menu, which allows you 
to have much more control over what colors 
become affected. In the video example, I felt 
that the yellows needed to be more saturated, 
so I set the color menu to affect the yellows 
and then I moved up the Saturation slider. 

The two top layers are clipped to the 
bottom layer.

In the Hue/Saturation Properties  
Panel, the color menu was set to  
Yellows and the Saturation slider is 
being moved up in order to make the 
yellows more colorful. 
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Place Multiple Adjustment Layers Inside a Masked Group (24:20)

This tip is similar to the concept of using clip-
ping masks in order to use one mask for mul-
tiple layers. If you have more than one adjust-
ment layer that should use the same mask, you 
can place those adjustment layers in a layer 
group (or folder) and then add a mask to the 
group. When you paint on a mask that is at-
tached to a group, it will affect all of the layers 
inside. 

Get Preview of Where Detail is Being Lost (27:38)

Earlier in the lesson, we learned about moving the white slider under the Curves 
chart to the left until it aligned with the histogram bars. This adds a white point 
to the area targeted by the adjustment layer.  If you ever move the dot beyond 
the edge of the histogram bars, it means that you are going to be losing detail in 
an area of your image. If you’d like to see where you might be losing detail, hold 
down the Option key (Alt on Win) and move the white slider. This will place an 
overlay on your image, where any white areas are losing detail and any colored 
areas are close to losing detail. This can serve as a good guide when adjusting 
the slider.  

The layer mask for the group is being 
applied to all of the layers inside. 

The Option key 
(Alt on Win) 
is being held 
down while 
moving the 
white slider. 
This causes 
an overlay to 
appear on the 
image, showing 
what areas are 
losing detail. 
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Create a Transitional Shadow (33:10)

In the video example, there are two sides to a service station image that don’t 
flow well together because of the shadow adjustment that was made. The shad-
ow on the left, sunlit side of the building looks darker than the front side of the 
building that was lightened. To make this look more natural, I created a soft shad-
ow that spanned across the front of the building, connecting with the shadow on 
the left side. Let’s look at how to accomplish something like this. 

We’ll create a new Curves Adjustment Lay-
er and we’ll mask it to reveal only the area 
where the light shadow should appear. Then 
we’ll do the opposite of what we did when 
pulling an area out of the shade. We’ll click 
on the top right dot of the curve line and 
we’ll drag it down. This takes areas that used 
to be white and darkens them to match the 
brightness range shown in the gradient on 
the left side of the Curves chart. We’ll drag 
is down, just until the shadow looks natural.

LEFT: The front side of the building looks unnaturally lit. RIGHT: A shadow was added, which 
connects with the shadow on the left side of the building, making the lighting look natural

The top right curve dot is being moved 
down, darkening the light areas.
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We could additionally adjust the color 
of this shadowed area. We’ll hold down 
Shift+Command (Shift+Ctrl on Win) and 
then use the Targeted Adjustment Tool 
to click on the color we want to shift. By 
holding down those keys, we are placing 
a point on each of the three color curves. 
Then we can use the color menu (above 
the Curves chart) to switch between the 
three curves and adjust the individual 
dots. 

After placing a point on each of the three 
color curves, each of the points can be ad-
justed separately in order to fine tune the 
color of the targeted areas.


